
Polyspace® Products for Ada

Installation Guide

R2013b



How to Contact MathWorks

www.mathworks.com Web
comp.soft-sys.matlab Newsgroup
www.mathworks.com/contact_TS.html Technical Support

suggest@mathworks.com Product enhancement suggestions
bugs@mathworks.com Bug reports
doc@mathworks.com Documentation error reports
service@mathworks.com Order status, license renewals, passcodes
info@mathworks.com Sales, pricing, and general information

508-647-7000 (Phone)

508-647-7001 (Fax)

The MathWorks, Inc.
3 Apple Hill Drive
Natick, MA 01760-2098
For contact information about worldwide offices, see the MathWorks Web site.

Polyspace® Products for Ada Installation Guide
© COPYRIGHT 2013 by The MathWorks, Inc.
The software described in this document is furnished under a license agreement. The software may be used
or copied only under the terms of the license agreement. No part of this manual may be photocopied or
reproduced in any form without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation
by, for, or through the federal government of the United States. By accepting delivery of the Program
or Documentation, the government hereby agrees that this software or documentation qualifies as
commercial computer software or commercial computer software documentation as such terms are used
or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and
conditions of this Agreement and only those rights specified in this Agreement, shall pertain to and govern
the use, modification, reproduction, release, performance, display, and disclosure of the Program and
Documentation by the federal government (or other entity acquiring for or through the federal government)
and shall supersede any conflicting contractual terms or conditions. If this License fails to meet the
government’s needs or is inconsistent in any respect with federal procurement law, the government agrees
to return the Program and Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See
www.mathworks.com/trademarks for a list of additional trademarks. Other product or brand
names may be trademarks or registered trademarks of their respective holders.

Patents

MathWorks products are protected by one or more U.S. patents. Please see
www.mathworks.com/patents for more information.

Revision History
September 2013 Online Only New for Version 6.6 (Release 2013b)

http://www.mathworks.com/trademarks
http://www.mathworks.com/patents


Contents

Before You Begin

1
Hardware and Software Requirements . . . . . . . . . . . . . . 1-2
Polyspace Product Requirements . . . . . . . . . . . . . . . . . . . . . 1-2
Polyspace Plug-In Requirements . . . . . . . . . . . . . . . . . . . . . 1-3
Polyspace Software License Requirements . . . . . . . . . . . . . 1-4
Linux Installation Requirements . . . . . . . . . . . . . . . . . . . . . 1-5

DVD Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6

Polyspace Installation Options . . . . . . . . . . . . . . . . . . . . . . 1-8

Polyspace Software Installation Folders . . . . . . . . . . . . . 1-11

Install Polyspace Software

2
Polyspace Products You Can Install . . . . . . . . . . . . . . . . . 2-2
Overview of Polyspace Products . . . . . . . . . . . . . . . . . . . . . . 2-2
Polyspace Client Software . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Polyspace Server Software . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2

Install the Polyspace Software . . . . . . . . . . . . . . . . . . . . . . 2-4
Before Starting the Installation . . . . . . . . . . . . . . . . . . . . . . 2-4
Install the Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-4
Activate Polyspace Software . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
Polyspace Software Icon . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-19
Configure the Polyspace Server . . . . . . . . . . . . . . . . . . . . . . 2-19

Start Installation from Command Line . . . . . . . . . . . . . . 2-24
Install Software on a Linux Platform . . . . . . . . . . . . . . . . . 2-24
Install Software in Silent Mode . . . . . . . . . . . . . . . . . . . . . . 2-24

iii



Modify Polyspace Configuration . . . . . . . . . . . . . . . . . . . . 2-26
Modify Polyspace Client Configuration . . . . . . . . . . . . . . . . 2-26
Modify Polyspace Server Configuration . . . . . . . . . . . . . . . . 2-27
Troubleshoot Common Errors . . . . . . . . . . . . . . . . . . . . . . . 2-33

Configure Polyspace Metrics Web Interface . . . . . . . . . . 2-37
Configure Preferences for Polyspace Metrics . . . . . . . . . . . 2-37
Configure Web Server for HTTPS . . . . . . . . . . . . . . . . . . . . 2-39
Specify Port Number of Polyspace Metrics Web Server in
Queue Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-41

Configure Polyspace Server for Multiple Client
Versions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-43
Windows Server Configuration . . . . . . . . . . . . . . . . . . . . . . 2-43
Linux Server Configuration . . . . . . . . . . . . . . . . . . . . . . . . . 2-45

Uninstall Polyspace Products

3
Uninstall Polyspace on Windows Platforms . . . . . . . . . . 3-2
Uninstalling Previous Releases on Windows . . . . . . . . . . . . 3-2
Uninstall Polyspace Software on Windows . . . . . . . . . . . . . 3-2

Uninstall on Linux Platforms . . . . . . . . . . . . . . . . . . . . . . . 3-4
Uninstalling Previous Releases on Linux . . . . . . . . . . . . . . 3-4
Uninstall Polyspace Software on Linux . . . . . . . . . . . . . . . . 3-4

Polyspace License Installation

4
Polyspace Licenses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Polyspace Licensing Options . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Obtain a License File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4

Common Licensing Questions . . . . . . . . . . . . . . . . . . . . . . 4-7

iv Contents



Do I need a FlexNet Server to Use an Individual
License? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-7

How Do I Identify Designated Computer and Concurrent
Licenses? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-7

What If I Have Other MathWorks Products Installed? . . . 4-7
What If I Have an Old Polyspace FLEXnet License
Server? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-8

Configure Designated Computer Licenses . . . . . . . . . . . 4-9
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-9
Install License Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-9
DC License File Format . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-10

Configure Concurrent Licenses . . . . . . . . . . . . . . . . . . . . . 4-11
Introduction to FlexNet Licensing . . . . . . . . . . . . . . . . . . . . 4-11
Install FlexNet Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-15
Configure a Concurrent License . . . . . . . . . . . . . . . . . . . . . . 4-18
Install Licenses on an Existing FlexNet Server . . . . . . . . . 4-23

Check Installed Licenses . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-24

License Error Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-25
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-25
Error -15, the FlexNet server is unreachable . . . . . . . . . . . 4-25
Error -5, the Polyspace feature is not available . . . . . . . . . 4-26
Error -21, license file does not support this version . . . . . . 4-26
Error -10, the license date has expired . . . . . . . . . . . . . . . . 4-26

Index

v



vi Contents



1

Before You Begin
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1 Before You Begin

Hardware and Software Requirements

In this section...

“Polyspace Product Requirements” on page 1-2

“Polyspace Plug-In Requirements” on page 1-3

“Polyspace Software License Requirements” on page 1-4

“Linux Installation Requirements” on page 1-5

Polyspace Product Requirements
Before you install Polyspace® software on a client or server workstation, your
hardware and software must meet the following requirements.

Requirement 32-Bit and 64-Bit

RAM 2 GB minimum

(4 GB recommended)

Processor Any Intel or AMD x86 processor supporting SSE2 instruction set

Operating system Linux:12

• Red Hat Enterprise Linux® 5.x and 6.x

• SUSE Linux Enterprise Desktop 11.x

• Debian 5.x3 and 6.x.

• Ubuntu 11.10 and 12.04 LTS

Windows:

• Windows® 7 or Service Pack 1

Windows XP (SP3)

• Windows Server® 2003 (R2 SP2)

• Windows Vista™ (SP2)

• Windows Server 2008 (SP2 or R2)
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Hardware and Software Requirements

Requirement 32-Bit and 64-Bit

For Windows systems, you must also install Microsoft® .NET Framework
3.5

Disk space for
installed software

2 GB minimum

(3 – 4 GB recommended)

Multi-core support Polyspace verification benefits from using multicore processors. The
minimum hardware required for a Polyspace Server is 4 core processors,
with 2 GB of RAM per core (4 GB of RAM per core recommended).

Note To install Polyspace software on a 64-bit Linux machine, you must
have the 32-bit libraries installed. The Polyspace installer uses 32-bit binary
files, which require these libraries.

Polyspace Plug-In Requirements
Before you install Polyspace link products or plug-ins, your hardware and
software must meet the following requirements.

Product Plug-In Software Release Operating
System

Polyspace plug-in for
Eclipse IDE4

Eclipse™ IDE for Ada
GNATbench

3.7 and 4.2 Linux, Windows
(32-bit only)

Excel Macros Microsoft Excel® 2007 and 2010 Windows

FLEXnet FlexNet® 11.9

1. The listed distributions are those Linux distributions that MathWorks® products have
been validated against. It is likely that other distributions with kernel version 2.6 or later
and glibc version 2.5 or later can successfully run MathWorks® products, but MathWorks
is in a limited position to provide technical support for those distributions.

2. Tested only for 64-bit Client and Server

3. Support will cease in a future release.

4. The Eclipse plug-in requires Java 7.
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1 Before You Begin

Polyspace Software License Requirements
Polyspace software provides two licensing options that, when combined with
the supported installation types, provide flexibility in redeploying product
licenses to different users.

Polyspace software provides the following license options.

License Option Protection Description

Designated Computer
(Individual)

MAC address or serial disk
number of the designated
computer

DC licenses are only for
Polyspace client software. DC
licenses are for users who
want to install and administer
the client software themselves.

A DC license is provided in a
text file.

Concurrent MAC address or serial disk
number of the FlexNet server

Concurrent licenses are for
both Polyspace client and
server software. Concurrent
licenses are for organizations
that use license keys to control
software access.

Concurrent licenses require a
FlexNet license manager.
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Hardware and Software Requirements

Linux Installation Requirements

Configuration
Check that the /tmp folder contains at least 10 MB of free space.

Environment Settings

• User path must include Polyspace_Install/bin (to start the product
without using the absolute path).

• Place the Polyspace license file in
Polyspace_Install/licenses/license.dat.

For more information, see “Polyspace Software Installation Folders” on page
1-11.

Access Rights
You must have Read and Execution access rights for all Polyspace software
installation.
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DVD Contents
Depending on the products that you purchase, from the Polyspace DVD
(or downloaded installer file), you can install one or both of the following
Polyspace products:

• Polyspace Client™ for Ada — Verify and review Ada83 and Ada95
source code.

• Polyspace Server™ for Ada — Verify Ada83 and Ada95 source code
on a dedicated server.

Note The difference between Polyspace Server and Polyspace Client products
is described in “Polyspace Installation Options” on page 1-8.

The DVD (or downloaded installer file) contains folders and program files.

Important folders and programs are:

• setup.exe — Runs the graphical installation wizard on a Windows
platform.

• install.sh — Runs the shell script installation wizard on a Linux
platform.
The -console option enables you to execute the command in a console
mode.
The -h option provides command options.

• version.txt — Text file with the complete version number of the
Polyspace product that is stored on the DVD.

• Docs— Folder with Polyspace installation guide, in PDF format.

• Data — Folder that contains Polyspace data.

• Installer32bits — Folder with installer for 32-bit version of Polyspace
product.

• Installer64bits — Folder with installer for 64-bit version of Polyspace
product.
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DVD Contents

Note After installation, the
Polyspace_Install\polyspace\examples\Language folder contains
subfolders with sample projects and verification results generated by
Polyspace software.
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Polyspace Installation Options
You can install the following products from the Polyspace installation DVD:

• Polyspace Client for Ada

• Polyspace Server for Ada

A client installation allows you to perform local verification, review previously
completed code verifications, and send new verification requests to a dedicated
server. You can use this option for developer machines. The installation
requires approximately 2 GB of disk space (3–4 GB is recommended). You
must have local administrator rights and access to the registry to complete
the installation.

A server installation allows a machine to receive verifications from clients.
This option is for machines dedicated to Polyspace software. The installation
requires approximately 2 GB of disk space (3–4 GB is recommended). You
must use a local user login with local administrator rights to complete the
installation.

A Polyspace Server can receive Polyspace verification requests from any
number of Polyspace Clients.
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Polyspace® Installation Options

��

����

��	
���

Polyspace® Client/Server Architecture

The following table describes some Polyspace terms.

Term Description

Polyspace Client Developer machine that requests Polyspace code
verifications to be performed on servers. You can install
any number of client systems.

Polyspace Server Computer that manages code verifications from a
number of clients. You can configure a server as either a
Queue Manager or a CPU.

Queue Manager
(QM)

A Polyspace Server that manages code verifications
from a number of clients. The Queue Manager can run
verifications, or dispatch verification jobs to other CPUs.
Typically, there is only one Queue Manager.

CPU A Polyspace Server that is dedicated to running code
verifications. A CPU receives verification jobs from the
QM and runs verifications. You can install any number
of CPUs.
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You can specify Polyspace client and server architectures that use
combinations of Windows and Linux machines. For example, you can install:

• Polyspace Clients on Windows machines and Polyspace Servers on Linux
machines

• Polyspace Clients on Linux machines and Polyspace Servers on Windows
machines

• The Polyspace Queue Manager on a Linux machine and Polyspace Servers
on Windows machines
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Polyspace® Software Installation Folders

Polyspace Software Installation Folders
Polyspace software is installed in the Polyspace_Install and
PolyspaceRLDatas folders.

The Polyspace_Install folder, which contains the kernel of the Polyspace
release, is located as follows:

• On a Windows system, Polyspace_Install is C:\Program
Files\Polyspace\PolyspaceForADA_Release. Release is the product
version. For example:

C:\Program Files\Polyspace\PolyspaceForADA_R2013b

• On a Linux system, Polyspace_Install is
/usr/local/Polyspace/PolyspaceForADA_Release. For example:

/usr/local/Polyspace/PolyspaceForADA_R2013b

The Polyspace_RLDatas folder, which stores data from server verifications,
is located as follows:

• On a Windows system with a previous release installed, the existing
PolyspaceRLDatas is used. For example:

C:\Polyspace\Polyspace_RLDatas

If no previous release is installed, the environment variable APPDATA
specifies the location of PolyspaceRLDatas.

• On a Linux system, the PolyspaceRLDatas folder is /var/Polyspace.

The Polyspace Server configuration file polyspace.conf is located as follows:

• On a Windows system, in the folder PolyspaceRLDatas.

• On a Linux system, in the folder /etc/Polyspace.
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Install Polyspace Software

• “Polyspace Products You Can Install” on page 2-2

• “Install the Polyspace Software” on page 2-4

• “Start Installation from Command Line” on page 2-24

• “Modify Polyspace Configuration” on page 2-26

• “Configure Polyspace Metrics Web Interface” on page 2-37

• “Configure Polyspace Server for Multiple Client Versions” on page 2-43



2 Install Polyspace® Software

Polyspace Products You Can Install

In this section...

“Overview of Polyspace Products” on page 2-2

“Polyspace Client Software” on page 2-2

“Polyspace Server Software” on page 2-2

Overview of Polyspace Products
The following sections describe how to install and configure these Polyspace
products:

• Polyspace Client for Ada

• Polyspace Server for Ada

Polyspace Client Software
Polyspace Client software is the management and visualization tool of
Polyspace products. Use it to submit jobs for execution by Polyspace Server,
and to review verification results. The Polyspace Client software includes
the following features:

• Polyspace verification environment (Project Manager perspective and
Results Manager perspective)

• Data Range Specification (DRS)

• Report Generator

Install the Polyspace Client software on developer machines that will send
verification jobs to the Polyspace Server.

Polyspace Server Software
Polyspace Server software is the computational engine of Polyspace products.
Use it to run jobs posted by Polyspace Clients, and to manage multiple servers
and queues. The Polyspace Server software includes the following features:

• Remote verification launcher
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Polyspace® Products You Can Install

• Polyspace Queue Manager (Spooler)

• Report Generator

• HTML Generator

Install the Polyspace Server software on machines (the Queue Manager and
CPUs) that are dedicated to receiving verifications from clients.
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2 Install Polyspace® Software

Install the Polyspace Software

In this section...

“Before Starting the Installation” on page 2-4

“Install the Software” on page 2-4

“Activate Polyspace Software” on page 2-9

“Polyspace Software Icon” on page 2-19

“Configure the Polyspace Server” on page 2-19

Before Starting the Installation
Before starting the installation process, check that you have the following:

• The Polyspace DVD (or downloaded installer file).

• Your email address and password for your MathWorks account.

• A local user login with administrator rights.

• At least 2 GB of free disk space (3–4 GB is recommended).

Install the Software
Polyspace software provides a graphical installation wizard that guides you
through the installation process. This wizard is available on Windows or
Linux platforms.

To install the Polyspace Client and Server software on a Windows computer:

1 Insert the Polyspace DVD into your DVD drive, or navigate to the installer
file that you downloaded from the MathWorks Web site.

2 Run setup.exe. (For a Linux system, run install.sh).

3 The Polyspace products installation wizard opens, displaying the
Introduction page. Click Next.
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Install the Polyspace® Software

4 On the License agreement page, select I accept the terms of the License
Agreement. Then click Next.

5 On the Install folder selection page, specify the folder in which you want
to install the Polyspace software.

The default folder for the product software is
C:\Polyspace\PolyspaceForADA.
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2 Install Polyspace® Software

6 Click Next.

7 On the Install preview page, click Install.
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Install the Polyspace® Software

8 The installation takes a few minutes, after which the Software installed
page opens. Click Done.
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2 Install Polyspace® Software

9 The Polyspace Software Activation wizard opens.
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Install the Polyspace® Software

Before you can use the Polyspace product, you must activate the software.

If you do not want to activate the software now, click Cancel. You can start
the activation process at any time after installation by selecting Start > All
Programs > Polyspace > Activate Polyspace.

For information about activation steps, see “Activate Polyspace Software”
on page 2-9.

Activate Polyspace Software
Activation is a process that verifies licensed use of MathWorks products. The
process validates your product licenses and makes sure that your licenses are
used correctly. Before you can use Polyspace software, you must complete
the activation process.

After you have completed the steps for installing the Polyspace software, the
Polyspace Software Activation wizard opens.
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2 Install Polyspace® Software

If you are using Designated Computer (Individual) licenses, you must activate
the license for each Polyspace system individually. However, if you are
using Concurrent licenses for multiple Polyspace systems, you do not need
to activate each Polyspace system. You activate the license once (for the
FLEXnet license server), then provide license files for each Polyspace system.

To complete the activation process, refer to the following sections:

• “Activate With Existing License File” on page 2-11

• “Activate Automatically (With Internet Connection)” on page 2-12

• “Activate Manually (Without Internet Connection)” on page 2-15

If you cancel the activation process, you can activate the software at any time
after installation by selecting Start > Programs > Polyspace > Activate
Polyspace.
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Install the Polyspace® Software

For more information on software activation, including
frequently asked questions, refer to the MathWorks Web site:
www.mathworks.com/support/activation/polyspace.html.

Activate With Existing License File
If you have an existing license file for the software that you are installing, you
can provide a path to the license file to complete the activation process. You
do not need to access the MathWorks License Center.

For example, if you use concurrent licenses for Polyspace software, your
license manager provides a license file for each Polyspace system. You do not
activate the software on each system, you just provide a path to this license
file.

Note With concurrent licenses, a FLEXnet license server manages licensing
of individual systems. You manually activate the concurrent license once
(using the License Center at the MathWorks Web site), and then provide
license files for each Polyspace system. For more information, see “Configure
Concurrent Licenses” on page 4-11.

To activate Polyspace software with an existing license file:

1 On the Polyspace Software Activation page, select Activate automatically
using the Internet. Then click Next.

2 On the Log In or Provide License File page, click Enter the full path to
your license file, including the file name.

2-11
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2 Install Polyspace® Software

3 Enter the path to your license file. Then click Next.

4 On the Activation Complete page, select Finish.

Activate Automatically (With Internet Connection)
If your Polyspace system is connected to the Internet, you can activate your
software automatically after installation. This process involves logging in to
your MathWorks account, and selecting the license that you want to activate.
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Install the Polyspace® Software

To activate your software automatically:

1 On the Polyspace Software Activation page, select Activate automatically
using the Internet. Then click Next.
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2 Install Polyspace® Software

2 On the Log in or Provide License File page, enter the login information for
your MathWorks account. Then click Next.

Note If you do not have a MathWorks account, click I need to create
and Account, and follow the instructions to create one.

3 On the License Selection page, select the license that you want to activate.
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Install the Polyspace® Software

Then click Next.

4 On the Confirmation page, click Activate.

Your license file is automatically copied to the Polyspace system.

5 On the Activation Complete page, click Finish.

Activate Manually (Without Internet Connection)
If your Polyspace system does not have an Internet connection, you must
activate your software manually. This process involves accessing the
MathWorks License Center from another computer, then manually copying
your license file to the Polyspace system.
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2 Install Polyspace® Software

To activate your software manually:

1 On the Polyspace Software Activation page, select Activate manually
without the Internet. Then click Next.

2 On the Offline Activation page, select I do not have a license file.
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Install the Polyspace® Software

Then click Next.

3 The License File Retrieval page displays the information that you need
to activate your software.

Save the information displayed on the page. For example, you can print a
copy by clicking Print.

4 From a computer with an Internet connection, go to the License Center at
the MathWorks Web site: http://www.mathworks.com/licensecenter.

5 Activate your license. Then download your license file.

For more information, refer to the License Center Help.

6 Copy your license file to the Polyspace folder.

7 Return to the Offline Activation page. Select Enter the full path to your
license file, including the file name. In the corresponding field, enter
the path to your license file. Then click Next.

2-17
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2 Install Polyspace® Software

Note If you closed the Polyspace Software Activation wizard, select
Start > Programs > Polyspace > Activate Polyspace to reopen the
wizard.

8 On the Activation Complete page, click Finish.
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Install the Polyspace® Software

Polyspace Software Icon
When installation is complete, the following icon appears on your desktop:

Click this icon to open the Polyspace verification environment, from which
you set up projects, start verifications, and review verification results.

Configure the Polyspace Server
After installing the Polyspace software, use the Metrics and Server Settings
dialog box to configure the Polyspace Server.

1 Open the Polyspace verification environment. From your desktop, click the
Polyspace icon.

Note In Windows 7, run Polyspace as an administrator. Right-click the
Polyspace icon. From the context menu, select Run as administrator.

2 Select Options > Metrics and Remote Server Setting.
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2 Install Polyspace® Software

To configure the server:

1 Specify the port through which the server communicates with clients. The
default port number is 12427. The port number must be the same as the
port number for all Polyspace Clients.

2 By default, the server is specified as a service on a Windows machine or a
daemon on a Linux machine
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Install the Polyspace® Software

On a Linux machine, if you do not select the Install server as service
(daemon) check box, you must configure the server manually after
installation. See “Manual Configuration of the Polyspace Server” on page
2-29.

3 Enter your user name and password. A password is not required on a
Linux machine.

4 In the Polyspace Server Settings section, specify the software versions
that you want the server to support. Use one of the following approaches:

• Click the folder button . Then use the Select a Polyspace product
dialog box to specify Polyspace_Install folders for the required
software versions.

• In the Available products field, enter the Polyspace_Install path for
a software version that you require. Then click the + button.

To remove an item from the list of supported software versions, select the
item. Then click the – button.

5 If you have purchased more than one license for your server, set the
Number of Polyspace verifications that can run simultaneously on
this server to the number of licenses you plan to activate for this machine.

6 Click Start Daemon. The software checks product paths, licenses, and the
creation and start up of the service (daemon). When the configuration check
is complete, you see the message Start of the daemon has succeeded.
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Note If a problem occurs, you see an error message in the Start Daemon
window. See “Troubleshoot Common Errors” on page 2-33.

7 Click OK.
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8 Click Close. By default, the server becomes the Queue Manager and first
CPU of the architecture.
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Start Installation from Command Line

In this section...

“Install Software on a Linux Platform” on page 2-24

“Install Software in Silent Mode” on page 2-24

Install Software on a Linux Platform
To install Polyspace products on a Linux system, in a terminal window,
execute the following command:

DVD/install.sh

This script opens the installation wizard. To complete the installation, refer
to “Install the Polyspace Software” on page 2-4.

Install Software in Silent Mode
By default, -silent mode performs a Polyspace software installation using
default parameters (auto server mode and 12427 for the port).

After installing the software, you must configure the Polyspace server
settings. For more information, see “Modify Polyspace Server Configuration”
on page 2-27.

Linux Platforms
To install the software on a Linux system using silent mode, in a terminal
window, run the following command:

DVD/install.sh -silent -install-dir Polyspace_Install

where Polyspace_Install represents the installation folder.

Windows Platforms
To install the software on a Windows system using silent mode, in a DOS
command window, run the following command:
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DVD\setup.exe -silent -install-dir Polyspace_Install

Polyspace_Install represents the installation folder.
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Modify Polyspace Configuration

In this section...

“Modify Polyspace Client Configuration” on page 2-26

“Modify Polyspace Server Configuration” on page 2-27

“Troubleshoot Common Errors” on page 2-33

Modify Polyspace Client Configuration

Initial Configuration
By default, the Polyspace Client is configured to automatically detect a
Polyspace Server on the network using port 12427.

Configure Polyspace Client Manually
By default, the Polyspace Client automatically detects any available Polyspace
Server configured as a Queue Manager on the network. However:

• If the Client finds more than one Polyspace Server, the Client displays an
error message listing the names of all detected servers. Carefully note all
names and close the error dialog box.

• If no Polyspace Server is available, you see the No QueueManager server
found error message when you start a verification or execute any Polyspace
command.

In these cases, to fix the error, you can specify a specific Queue Manager
server associated with a specific port number.

To manually configure the remote server:

1 In the Polyspace verification environment, select Options > Preferences.

2 In the Polyspace Preferences dialog box, click the Server configuration
tab.
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3 In the Remote configuration section, click Use the following server and
port.

4 Enter an IP address (or server name) and the associated port number
(default 12427) for the Polyspace Server. You must use the same port
number for all clients, the Queue Manager, and all servers.

5 If required, configure access to Polyspace Metrics. See “Configure Polyspace
Metrics Web Interface” on page 2-37.

6 Click OK.

The preferences are stored in the polyspace.prf
preferences file in %AppData%\Polyspace
(C:\Users\username\AppData\Roaming\Polyspace\polyspace.prf
on a Windows system).

Note Do not modify this file with an ASCII editor. Use the Metrics and
Remote Server Settings dialog box to modify values in this file.

Modify Polyspace Server Configuration

• “Update Polyspace Server Configuration” on page 2-28

• “Manual Configuration of the Polyspace Server” on page 2-29

• “Configuration Files on Windows Platform” on page 2-31

2-27



2 Install Polyspace® Software

• “Adding a New CPU” on page 2-32

• “Configuration Files on Linux Platform” on page 2-33

Update Polyspace Server Configuration
The default Polyspace Server configuration specifies that the server is both
the Queue Manager and a CPU. However, after installing the software, you
can update the configuration through the Metrics and Remote Server Settings
dialog box.

To update your server configuration (polyspace.conf):

1 Open the Polyspace verification environment. From your desktop,
double-click the Polyspace icon.

Note In Windows 7, run Polyspace as an administrator. Right-click the
Polyspace icon. From the context menu, select Run as administrator.

2 Select Options > Metrics and Remote Server Setting.

Note You can also run the command
Polyspace_Install/polyspace/bin/polyspace-rl-manager.exe.

3 Stop the current Queue Manager. Click Stop Daemon. You must stop the
current Queue Manager before you can change any parameters.

4 Under Common Settings, specify:

• Communication port — Port number that is used by all clients, the
Queue Manager, and all servers.
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• Folder where analysis data will be stored— Location for data from
server verifications.

5 If you want the host machine to be the Queue Manager, under Queue
Manager Settings, specify the Queue Manager and all CPUs.

To specify the Queue Manager or a CPU, in the Available Polyspace
Servers field, enter Machine_name_or_IP_address[:port_number]. For
example, SERVER1 or 012.123.4.56:12427. Then click +.

6 If you do not want the host machine to be a Queue Manager, under Queue
Manager Settings, remove entries from the displayed list.

For example, to remove a CPU from the specified list, select the CPU. Then
click –.

7 Under Polyspace Server Settings, specify:

• Available products — Location of Polyspace products installed on
the server.

• Available languages — Available languages.

8 In the Number of Polyspace verifications that can run
simultaneously on this server field, specify the number of licenses you
have activated for the machine.

9 Click Apply.

10 Click Start Daemon.

The file Polyspace_RLDatas/polyspaced.log
(/var/Polyspace/polyspaced.log) contains the information that the
software displays when you click Start Daemon or Stop Daemon .

Manual Configuration of the Polyspace Server
The polyspace.conf file specifies the configuration of the Polyspace Server.

You can manually create or modify the configuration file with the
command Polyspace_Install/polyspace/bin/setup-remote-launcher.
For information about options, run
Polyspace_Install/polyspace/bin/setup-remote-launcher -h.
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The configuration file contains fields that define the Queue Manager and CPU
architecture. By default, the Polyspace Server is both the Queue Manager
and a CPU.

Specify the Polyspace Server configuration through the following fields:

• product=— Installation folder Polyspace_Install for Polyspace software.
One per language.

• lang= — Verification language, which specifies the supported language
declaration (CPU only). Values can be Ada, Ada83, ADA, Ada95 and ADA95.

• username= — User name used to run the daemon process. On a Linux
system, if the daemon is started as root, the daemon automatically
changes its user ID to run as the user.

• datadir=— Name of the folder where data from remote verifications are
stored. Default is PolyspaceRLDatas.

• locksdir= — Name of the folder where the locks are stored. If not
specified, datadir/locks is used.

• port=— Number of the port for which the daemon listens. Default value is
12427. The number can be between 10000 and 15000. This range depends
on the operating system requirements.

• cpu=— Machine name to specify Queue Manager, or IP address and port
number to specify CPU.

Use the syntax IP_Address_or_CPU_Name[:Port_Number]. For example:

cpu=MYHOST
cpu=192.168.2.79:12428

The first line specifies the machine for the Queue Manager. The second
line specifies a CPU to which the Queue Manager sends verification jobs.

• results_repository_dir= — Results repository folder for Polyspace
Metrics. The default is datadir/results-repository.

• process_automation=—Flag that specifies whether automatic verification
is activated (yes). The default is no. If automatic verification is activated,
then Polyspace verifies your code according to the configuration that you
provide in the file results_repository_dir/Projects.psproj.
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To make changes to the configuration file, you must stop the associated
daemon (service). Run the command:

Polyspace_Install/polyspace/bin/setup-remote-launcher
-stop-service

To start or restart the daemon (service), run the command:

Polyspace_Install/polyspace/bin/setup-remote-launcher -start-service

On a Linux machine, if you have not specified the Queue Manager as a
daemon, run the following command to install the daemon:

Polyspace_Install/Polyspace/bin/setup-remote-launcher
-install-service

To start the Queue Manager daemon, run:

Polyspace_Install/polyspace/bin/polyspaced

To stop the Queue Manager daemon, run:

Polyspace_Install/polyspace/bin/polyspaced -stop

Note You can manage the Polyspace daemon from the /etc/init.d
install services folder.

Configuration Files on Windows Platform
The Polyspace_RLDatas folder contains the following:

• polyspaced.log— Log file that contains information generated by:

- The installation process

- Communication between the Queue Manager and clients for the life
span of the Queue Manager.

• queue_infos.txt— File that contains verification job information from
the Queue Manager, for example ID, Author, and Application.

• locks— Folder that contains the locks file for each verification.
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• polyspace.conf— Configuration file. For example, the configuration for a
Polyspace Server can contain the following:

product=C:\Program Files\Polyspace\PolyspaceForAda_R2013a
lang=Ada95
datadir=C:\Polyspace\Polyspace_RLDatas
username=auser
cpu=HOSTQM
cpu=192.168.2.79:12428

In this example, the products used are installed in:

C:\Program Files\Polyspace\PolyspaceForAda_R2013a

The machine HOSTQM is configured to be a Queue Manager and a CPU for
Ada95 code verifications. The port number is the default value 12427. In
addition, another CPU with IP address 192.168.2.79 is specified with
port number 12428.

On a Linux system, by default, the folder locks is located in /var/Polyspace.

Adding a New CPU
To add a new CPU to your existing Polyspace Client/Server architecture:

1 Install Polyspace software on the host machine for the new CPU. See
“Install the Software” on page 2-4.

2 Using the Metrics and Remote Server Settings dialog box, configure the
new machine to be a Polyspace Server. See “Configure the Polyspace
Server” on page 2-19.

To specify that this server is a CPU but not a Queue Manager, under
Queue Manager Settings, remove all entries from the Polyspace
Servers list. Alternatively, manually remove all cpu= fields from the
configuration file polyspace.conf.

3 On the host machine for the Queue Manager, specify a new CPU in the
configuration file polyspace.conf. Using a text editor, add the following
line:

cpu=CPU_Name_or_IP_Address[:Port_Number]
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For example:.

product=C:\Program Files\Polyspace\PolyspaceForAda_R2013a
lang=Ada95
datadir=C:\Polyspace\Polyspace_RLDatas
username=auser
cpu=HOSTFORQM
cpu=192.168.2.79:12428

Configuration Files on Linux Platform
When you install the Polyspace daemon, the software creates the following:

• /var/Polyspace— Folder that contains, for example, subfolders lock and
analysisN, and files polyspaced.log and queue_infos.txt.

• /etc/Polyspace/polyspace.conf — File that contains Polyspace
configuration information.

• /etc/init.d/polyspaced — File that is used to start, stop, and restart
the daemon.

• /tmp/polyspace— Folder to store all temporary files.

Note If you do not have write access to all of these locations, you cannot
install the daemon .

Troubleshoot Common Errors
This section contains information on troubleshooting the following common
errors:

• “Errors Concerning the polyspace.conf File” on page 2-34

• “Errors Concerning Problems with Write Access” on page 2-35

• “Java Not Found Errors” on page 2-36

• “Other Errors” on page 2-36
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Errors Concerning the polyspace.conf File
If you receive any errors concerning the polyspace.conf file:

1 Stop the polyspacedservice (daemon).

2 Update the polyspace.conf file.

3 Restart the service (daemon).

The following errors concern the polyspace.conf file.

• "Error: The data folder path should not contain white space.";

• "Error: At least one language should be supported by the
CPU.";

• "<polyspace.conf>:<line_number>: Duplicate entry for product
<version value>.";

• "<polyspace.conf>:<line_number>: Unknown language :
<value>.";

• "<polyspace.conf>:<line_number>: Duplicate entry for language
<value>.";

• "<polyspace.conf>:<line_number>: Duplicate entry for
<queuemanager name>. ";

• "<polyspace.conf>:<line_number>: Duplicate entry for
<value>.";

• "<polyspace.conf>:<line_number>: Duplicate entry for
username'.";

• "<polyspace.conf>:<line_number>: Duplicate entry for
'port'.";

• "<polyspace.conf>:<line_number>: Invalid port number :
<value>";

• "<polyspace.conf>:<line_number>: Invalid CPU name.";

• "<polyspace.conf>:<line_number>: Duplicate entry for CPU
<hostname> ";

• "<polyspace.conf>:<line_number>: Unknown key : <value> ";
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• "<polyspace.conf>:<line_number>: Parse error.";

• "No Polyspace product found for language <value>.";

• "Warning: Invalid <lang> license for product <version> on
host <hostname> ";

• "The Polyspace product <version> was not found.";

Errors Concerning Problems with Write Access
If you see any of the following errors, check that the username declared in the
polyspace.conf file has write access permission for the folder, filename, or
path specified in the error message:

• "Fatal error: Directory folder is not accessible.";

• "Fatal error: Could not change the owner of path to username
";

• "Fatal error: Could not open file filename for reading.";

• "Fatal error: Could not set permissions on path "

• "Fatal error: Could not open file filename

Without stopping the daemon (service), check that you have not changed
anything linked to the polyspaced daemon (service).

If your datadir folder is not local, you must specify a local locksdir folder in
the polyspace.conf file. For example:

...
# Remote Launcher configuration.
#

datadir=/nfs/nfsxxx/folder
locksdir=local_folder
cpu=...
...
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Java Not Found Errors
When installing a Polyspace product on a 64-bit Linux machine, the
installation program may end with the following error message:

exec: 2433: /tmp/install.dir.880/Linux/resource/jre/bin/java: not found

This error occurs because the Polyspace installer is itself a 32-bit binary file
that uses 32-bit binary files. This use of 32-bit files can cause problems on a
64-bit machine.

To solve this problem, install the 32-bit libraries. For example, on an Ubuntu
64-bit Linux machine, install the packageia32-libs from your Linux
distribution.

For more information on installing these libraries, refer to the documentation
for your Linux distribution.

Other Errors
Other errors may concern operating system, network, and standard
commands available (for example, tar and gzip).

Verify that these standard commands exist in your system. Error messages
indicate which command has failed.
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Configure Polyspace Metrics Web Interface

In this section...

“Configure Preferences for Polyspace Metrics” on page 2-37

“Configure Web Server for HTTPS” on page 2-39

“Specify Port Number of Polyspace Metrics Web Server in Queue Manager”
on page 2-41

Configure Preferences for Polyspace Metrics
Polyspace Metrics is a Web-based tool that allows you to evaluate and monitor
software quality throughout the lifecycle of a project. Polyspace Metrics
communicates directly with the Polyspace Client and Server software. You
must set up a Polyspace Metrics Web server for this communication to work
properly.

Before setting up the Polyspace Metrics server, you must first configure
your Queue Manager server. The Queue Manager server carries out the
verification and creates the results repository for Polyspace Metrics.

To configure access to Polyspace Metrics:

1 Select Options > Preferences to open the Polyspace Preferences dialog
box.

2 Click the Server configuration tab.
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3 In the Metrics configuration section, select Download results
automatically. Specify a local folder for downloading result files from the
Polyspace Metrics Web interface.

In the Metrics Web interface, when you click an item to view it in Polyspace,
the software downloads results to the verification launch folder. However,
if this folder does not exist, the software downloads results to the folder
specified in the Folder field, which is C:\Temp by default.

If you do not select this check box, when you click an item in Polyspace
Metrics, a dialog box opens. In this dialog box, you can specify your locally
accessible folder. When you exit Polyspace, the folder and its contents
are not deleted.

4 In the Port number field, specify the port number for communication
between Polyspace and the Metrics Web interface. The default is 12428.
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5 In the Web server port number field, specify the port number for the
Web server. The default is 8080 for HTTP.

If you use HTTPS for your Web protocol, select Use secure HTTPS
protocol instead of HTTP protocol to access Metrics results. Specify
your port number in the corresponding field. The default is 8443 for
HTTPS. There are additional steps to set up the Web server for HTTPS.
See “Configure Web Server for HTTPS” on page 2-39.

If you changed the port number from the default, you must configure
the same port number for the Queue Manager server. See “Specify Port
Number of Polyspace Metrics Web Server in Queue Manager” on page 2-41 .

Access the Polyspace Metrics Web interface with:

protocol://ServerName:WSPN

• protocol is either http or https.

• ServerName is the name or IP address of the Queue Manager server.

• WSPN is the Web server port number.

Configure Web Server for HTTPS
Data transfers between the Polyspace Server and the Polyspace Client are
always encrypted. However, the data transfer to the Polyspace Metrics Web
interface is not encrypted. You can enable HTTPS for the Web protocol, which
encrypts the data transfer to the Polyspace Metrics Web interface. To set up
HTTPS, you must change the server configuration and set up a keystore for
the HTTPS certificate.

Before you start the following procedure, you must complete “Configure
Preferences for Polyspace Metrics” on page 2-37.

To configure HTTPS access to Polyspace Metrics:

1 Open the Metrics and Remote Server Settings dialog box. Run the following
command:

Polyspace_Install\polyspace\bin\polyspace-rl-manager.exe
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2 Click Stop Daemon. The Queue Manager server daemon is stopped so
that you can make the necessary changes for HTTPS.

3 Open the Polyspace_RLDatas\tomcat\conf\server.xml file in a text
editor. Look for the following text:

<!-
<Connector port="8443" SSLEnabled="true" scheme="https"
secure="true" clientAuth="false" sslProtocol="TLS"
keystoreFile="<datadir>/.keystore" keystorePass="polyspace"/>

->
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If the text is not in your server.xml file:

a Delete the entire ..\conf\ folder.

b In the Metrics and Remote Server Settings dialog box, restart the
daemon by clicking Start Daemon.

c Click Stop Daemon to stop the Queue Manager daemon again so that
you can finish setting up the server for HTTPS.

The conf folder is regenerated, including the server.xml file. The file now
contains the necessary text to configure the HTTPS Web server.

4 Follow the commented-out instructions in server.xml to create a keystore
for the HTTPS certificate.

5 In the Metrics and Remote Server Settings dialog box, click Start Daemon
to restart the Queue Manager daemon with the changes.

You can now access the Polyspace Metrics Web interface with:

https://ServerName:WSPN

• ServerName is the name or IP address of the Queue Manager server.

• WSPN is the Web server port number.

Specify Port Number of Polyspace Metrics Web
Server in Queue Manager
If you change or specify a non-default value for the Web server port number
of your Polyspace Client, you must manually configure the same value for
your Queue Manager.

In Polyspace_RLDatas\tomcat\conf\server.xml, edit the port attribute of
the Connector element for your Web server protocol.

• For HTTP:

<Connector port="8080"/>

• For HTTPS:
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<Connector port="8443" SSLEnabled="true" scheme="https"
secure="true" clientAuth="false" sslProtocol="TLS"
keystoreFile="<datadir>/.keystore" keystorePass="polyspace"/>
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Configure Polyspace Server for Multiple Client Versions
You can upgrade your Polyspace Server, and configure it to process jobs from
clients running previous versions of the software. This feature allows you to
avoid updating the server and all client machines at the same time.

Note To configure your server to support two releases, you must install the
older release first, and then install the newer release on top of it. If you install
the newer release first, you must uninstall it before proceeding.

Windows Server Configuration
To configure a Windows server to support two software versions:

1 Install the older version of the Polyspace Server software.

2 Install the newer version of the Polyspace Server software.

When installation is complete, you have two PolyspaceForProduct folders,
one for each release. For example:

C:\Program Files\Polyspace\PolyspaceForADA_R2013a
C:\Polyspace\PolyspaceForADA_R2012b

3 Open the Metrics and Remote Server Settings dialog box.

2-43



2 Install Polyspace® Software

The list of products currently supported by the server appears in
the Polyspace Server Settings section. In the previous figure,
PolyspaceForADA_R2013a is the only product currently supported by the
server.

4 In the Polyspace Server Settings section, click the folder button ,
and then select the folder for the Polyspace software version that you want
to support.

For example, C:\Polyspace\PolyspaceForADA_R2012b.
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5 Click Apply to save your changes.

6 Click Start Daemon to restart the daemon (service) with the changes.

The Polyspace server automatically chooses the product version, based on the
software version of the client that submitted the job.

Linux Server Configuration
To configure a Linux server to support two software versions:

1 Install the older version of the Polyspace Server.

2 Install the newer version of the Polyspace Server. You must select the
same Polyspace root folder.

When installation is complete, the Polyspace root folder
(/usr/local/Polyspace) contains two PolyspaceForProduct folders, one
for each release. For example:

/PolyspaceForAda_R2013a
/PolyspaceForAda_R2012b

3 Open the file /etc/polyspace/polyspace.conf.

4 Find the product= line for the current software version, for example:
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product=/usr/local/Polyspace/PolyspaceForAda_R2013a

5 Add a new product= line for the previous software version, for example:

product=/usr/local/Polyspace/PolyspaceForAda_R2012b

6 Restart the daemon by running the following root command:

/etc/init.d/polyspaced restart

Using the software version of the client that submitted the job, the Polyspace
Server automatically chooses the required product version.
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Uninstall Polyspace on Windows Platforms

In this section...

“Uninstalling Previous Releases on Windows” on page 3-2

“Uninstall Polyspace Software on Windows” on page 3-2

Uninstalling Previous Releases on Windows
If you are upgrading your existing Polyspace software to the latest release:

• If you currently run a release that is from the release range R2008a –
R2012b, do not uninstall the release before installing the new release. The
new server software can run verifications from both releases. However,
before you install the new release, you must stop the Polyspace service
(daemon). Use the Remote Launcher Manager to check whether the service
is running, and, if required, stop the service. To open the Remote Launcher
Manager, run the following command:

%POLYSPACE_COMMON%\RemoteLauncher\PSTRLManager.exe

After installing the new release, you can use the Remote Launcher
Manager to restart the service.

• If you currently run release R2007a+ or earlier, you must uninstall the
release before installing the new release. R2007a+ and earlier releases use
the Cygwin API, which is incompatible with the new release.

Uninstall Polyspace Software on Windows
You can uninstall the Polyspace software through the standard interface
available on a Windows PC.

To uninstall the Polyspace software:

1 From the Windows desktop, select Start > Control Panel > Programs
and Features.

2 Select the Polyspace product that you want to uninstall.

3 On the toolbar, clickUninstall. Then follow the uninstallation instructions.
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Note Some files and folders added after installation can remain after the
uninstall process is complete. After restarting your machine, check the
Polyspace_Install folder for files and subfolders. You can remove these
remaining files manually.
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Uninstall on Linux Platforms

In this section...

“Uninstalling Previous Releases on Linux” on page 3-4

“Uninstall Polyspace Software on Linux” on page 3-4

Uninstalling Previous Releases on Linux
If you are upgrading your existing Polyspace software to the latest release,
you do not need to uninstall the existing software before installing the new
release. The new server software can run verifications from both releases.

Before installing the new release, you must stop the polyspaced
daemon. Using an administrator login, you can run the command
/etc/init.d/polyspaced stop to stop the daemon. After installing, you can
restart the daemon using the command /etc/init.d/polyspaced start.

Uninstall Polyspace Software on Linux
To uninstall components on a Linux system:

• Run Polyspace_Install/Uninstall/Uninstall .

This script opens the graphical uninstall wizard.
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Polyspace Licenses

In this section...

“Polyspace Licensing Options” on page 4-2

“Obtain a License File” on page 4-4

Polyspace Licensing Options
There are two licensing options:

• “Designated Computer (Individual) Licenses” on page 4-2

• “Concurrent (Floating) Licenses” on page 4-3

Designated Computer (Individual) Licenses
Designated Computer (DC) licenses are only for Polyspace client software. DC
licenses are for users who want to install, operate, and administer the client
software themselves. A DC license authorizes you to use your Polyspace client
software on one computer system to which you have access. The system you
choose can be a Microsoft Windows or Linux computer.

With a DC license, you are the system administrator. In this role, you are
responsible for:

• Installing and activating the Polyspace Client software on your computer.

• Verifying that you are the only person who runs the software on your
computer.

To generate a DC license, you must activate your software using either
the Polyspace Software Activation Client, or the License Center at the
MathWorks Web site. To obtain a DC license, refer to “Check Installed
Licenses” on page 4-24.

Note DC licenses do not use the FlexNet server.
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Concurrent (Floating) Licenses
Concurrent licenses are for both Polyspace Client and Polyspace Server
software. Concurrent licenses are for organizations that have standardized on
the FlexNet license manager, or who want to impose limits on software use
for accounting or license management purposes.

Concurrent licenses use license keys to control access. When users open
a Polyspace product, they check out a license key. When all the keys for
a particular product are checked out, the license manager denies further
requests.

A Network Named User (NNU) configuration is an option for concurrent
licensing that can be set up as a protective measure to restrict the usage of
shared licenses.

The system administrator for concurrent licenses must set up an installation
that optimizes accessibility to the products. Concurrent licenses allow you to
install the software only in a Network Concurrent User installation type.

Polyspace® FlexNet® Server Architecture
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The previous figure shows how to use Polyspace products with a FlexNet
license manager. With a Polyspace products with a FlexNet license manager:

• Polyspace products are used by any number of users. The Polyspace
products can include both Client and Server products.

• Each Polyspace product requests licenses from the FlexNet server.

• The FlexNet server can be installed on the same machine as a Polyspace
product, as long as it is running a mutually supported operating system
(see “Supported Machines and Versions” on page 4-14).

Note With concurrent licenses, you do not need to activate the software on
each Polyspace system. You manually activate the concurrent license once
(using the License Center at the MathWorks Web site), and then provide
license files for each Polyspace system.

Obtain a License File
When you activate your software through the MathWorks Activation Client,
you automatically receive a license file. There are no additional steps.

If you are using a concurrent license, or do not have access to the
Activation Client, you must obtain a license file from MathWorks. You can
obtain license files from the License Center at the MathWorks Web site:
http://www.mathworks.com/licensecenter.

To obtain a concurrent license file, you need either the MAC address or
serial disk number of your computer. Provide this number to MathWorks to
obtain the license file.

Get License hostid on Linux Platforms
On a Linux machine, the hostid corresponds to the MAC address of the
machine where the FlexNet server is running (using a concurrent license) or
where the DC license is used.

You can display the hostid of a Linux machine using the
lmutil FlexNet utility, which is available on the Polyspace DVD
at DVD/Data/Unix/FLEXLM/glnxa64.
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Use the following command:

./lmutil lmhostid

The result in a shell window looks like the following:

lmutil - Copyright (c) 1989-2007 by Macrovision Corporation.
All rights reserved.

The FLEXlm host ID of this machine is "831da5d6"

To obtain the license file, send the alphanumeric string (in quotes) to
MathWorks.

Get License hostid on Windows Platforms
On a Windows machine, hostid or machine_hostid corresponds to the serial
disk number of the machine where the FlexNet server is running (using a
concurrent license) or where the DC license is used.

You can display the hostid of a Windows machine using the
lmtools.exe FlexNet utility, which is available on the Polyspace DVD at
DVD\Data\Windows\FLEXLM\win32.

To view the hostid:

1 From the DVD\Data\Windows\FLEXLM\win32 folder, double-click lmtools.

2 In the LMTOOLS dialog box, click the System Settings tab.

The Disk Volume Serial Number field contains an alphanumeric string. To
obtain the license file, send this string to MathWorks.

Alternatively, from the DOS command window, run the following:

DVD\Data\Windows\FLEXLM\win32>lmutil.exe lmhostid -vsn

The result looks like the following:

lmutil - Copyright (c) 1989-2007 by Macrovision Corporation.
All rights reserved
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The FLEXlm host ID of this machine is "DISK_SERIAL_NUM=e855c07a"
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Common Licensing Questions

In this section...

“Do I need a FlexNet Server to Use an Individual License?” on page 4-7

“How Do I Identify Designated Computer and Concurrent Licenses?” on
page 4-7

“What If I Have Other MathWorks Products Installed?” on page 4-7

“What If I Have an Old Polyspace FLEXnet License Server?” on page 4-8

Do I need a FlexNet Server to Use an Individual
License?
No. Designated Computer (individual) licenses do not use the FlexNet server.

For more information, see “Configure Designated Computer Licenses” on
page 4-9.

How Do I Identify Designated Computer and
Concurrent Licenses?
DC license files have the word uncounted in the license line. This line is
used directly in the license file. See the example in “DC License File Format”
on page 4-10.

What If I Have Other MathWorks Products Installed?
Polyspace products use the same license mechanism as other MathWorks
products.

If you receive a Designated Computer license for Polyspace products, refer to
“Configure Designated Computer Licenses” on page 4-9.

If you receive a Concurrent License and you already use a FlexNet Server for
other MathWorks products, you must add all concurrent INCREMENT lines in
the Polyspace license to the FlexNet Server.
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For license configuration information, refer to “Configure Licenses on a
Polyspace Client or Polyspace Server System” on page 4-19.

What If I Have an Old Polyspace FLEXnet License
Server?
To use Polyspace products release R2007a+ or later, you must upgrade the
FlexNet Server to the version available on the Polyspace product DVD. The
upgrade process involves uninstalling your old FlexNet server and installing
the new one.

For installation information, see “Install FlexNet Manager” on page 4-15.

For license configuration information, refer to “Configure Concurrent
Licenses” on page 4-11 for licensing information.
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Configure Designated Computer Licenses

In this section...

“Overview” on page 4-9

“Install License Files” on page 4-9

“DC License File Format” on page 4-10

Overview
This section describes how to install a Designated Computer (individual)
license for Polyspace products, using a license.dat file. It also describes
how to check license usage.

Designated Computer licenses are available only for Polyspace client software

Note When you activate your software through the MathWorks Activation
Client, your license is configured automatically. You do not need to take
any additional steps.

Install License Files
To install a Designated Computer license, you must copy the license.dat
file to the required location. The same license.dat file must be used for all
Polyspace products and must be set up with the standard Polyspace subfolder
localization (see format in “DC License File Format” on page 4-10).

Note Remove previous license.dat files from the licenses folder.

Place the license file in the Polyspace_Install/licenses folder. For
example, on a Windows platform, if you installed the Polyspace software in
the default folder, place license.dat:

C:\Program Files\Polyspace\PolyspaceForADA_R2013a\licenses\
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DC License File Format
The DC license is for an individual user and computer. It does not require a
FlexNet license manager to be running. It has the following format:

INCREMENT Polyspace_Feature MLM passcode_version_number
date_of_license_end uncounted key HOSTID=machine_hostid
SN=serial_number

machine_hostid — hostid of the machine, usually the MAC address on
a Linux system and the disk serial number on a Windows system. The
machine_hostid is required to obtain a license file from MathWorks. For
more information, see Getting the License hostid.

Example

# MATLAB license passcode file.
# License No: 517786
INCREMENT Polyspace_Client_ADA MLM 19 3-jan-2008 uncounted \

ABCDEF12345678A HOSTID=DISK_SERIAL_NUM=388ab914 SN=517786 TS_OK
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Configure Concurrent Licenses

In this section...

“Introduction to FlexNet Licensing” on page 4-11

“Install FlexNet Manager” on page 4-15

“Configure a Concurrent License” on page 4-18

“Install Licenses on an Existing FlexNet Server” on page 4-23

Introduction to FlexNet Licensing

• “What Is FlexNet Manager?” on page 4-11

• “FlexNet Software Components” on page 4-11

• “Supported Machines and Versions” on page 4-14

What Is FlexNet Manager?
A concurrent license requires FlexNet Manager. Macrovision® FLEXnet®

Manager is a network license manager that controls the use of Polyspace
software products.

FlexNet Manager allows software licenses to be available anywhere on a
network, instead of being tied to specific machines. Floating licensing benefits
both users and license administrators. Users make more efficient use of fewer
licenses by sharing them on the network. License managers control the users
and machines that have access to the software managed by FlexNet Manager.

Note FlexNet Manager is not automatically installed as part of the Polyspace
software installation. For information about installing the FlexNet software,
see “Install FlexNet Manager” on page 4-15 .

FlexNet Software Components

• “Windows Platforms” on page 4-13
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• “Linux Platforms” on page 4-14
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Windows Platforms. On a Windows system, the following software
components relate to the standard FlexNet package.

FlexNet Component Description

license.dat License file. If you do not have a license,
contact MathWorks.

lmtools.exe Allows you to manage the license.

MLM.exe Vendor service that keeps track of the
number of licenses checked out, and where
they are.

lmgrd.exe License service that handles the initial
contact with Polyspace products, passing the
connection on to MLM.exe. This service also
starts and restarts MLM.exe.

lmutil.exe Allows you to perform license server
management and administration, for
example, displaying the MAC address, IP
address, disk serial number, and user name.
Can be used from the command line.
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Linux Platforms. On a Linux system, the following software components
relate to the standard FlexNet package.

FlexNet Component Description

MLM Vendor service that keeps track of the
number of licenses checked out, and where
they are.

lmgrd License daemon that handles the initial
contact with Polyspace products, passing
the connection on to MLM.exe. This service
also starts and restarts MLM.exe.

lmutil Allows you to manage the license server,
for example, displaying the MAC address,
IP address, disk serial number, and user
name.

Note To install these components, copy them from the following DVD folder:

DVD/Data/Unix/FLEXLM/glnxa64.

Supported Machines and Versions

• “Supported FlexNet Releases” on page 4-14

• “Supported Machines” on page 4-14

• “Network Recommendations for Concurrent Licensing” on page 4-15

Supported FlexNet Releases. Polyspace products support FlexNet release
11.9.

Supported Machines. You can install the FlexNet server on all platforms
supported by Polyspace products.
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Network Recommendations for Concurrent Licensing. You must have a
good network configuration for the FlexNet client to obtain good performance
for your Polyspace verifications.

If the client machine knows the FlexNet server in its hosts file, Polyspace
verifications run quickly. However, if the client machine does not know the
FlexNet server (ping server_name does not work), the Polyspace verification
takes more than twice the time.

Install FlexNet Manager

• “Install FlexNet Manager on Windows Systems” on page 4-15

• “Install FlexNet Manager on Linux Systems” on page 4-17

Install FlexNet Manager on Windows Systems

• “Software Location” on page 4-15

• “Install the FlexNet Server” on page 4-15

• “Configure the License Manager” on page 4-16

FlexNet Manager is not installed as part of the Polyspace software
installation.

Software Location. The FlexNet software components are located on the
Polyspace Products DVD in:

DVD\Data\Windows\FLEXLM\win32.

Install the FlexNet Server. Installation consists of a copy and paste:

1 Copy the DVD\Data\Windows\FLEXLM\win32 folder to a permanent folder
on the machine.

2 Copy the license file (license.lic ) to this permanent folder.
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Configure the License Manager. Before setting up the FlexNet server,
you must update the license.dat file with the name of the server, or its IP
address. For more information, see “Configure a Concurrent License” on
page 4-18.

You must have Administrator privileges to configure a license server as a
service.

To configure the license server as a service:

1 Run lmtools.exe, which opens The LMTOOLS dialog box.

2 On the Service/License File tab, click Configuration using Services.

3 Click the Config Services tab.

4 In the Service Name field, specify the name of the service that you want
to define, for example, Polyspace FLEXlm Server.

5 In the Path to the lmgrd.exe file field, enter the required file path.
Alternatively, click Browse and navigate to lmgrd.exe.

6 In the Path to the license file field, enter the required file path.
Alternatively, click Browse and navigate to the license file, license.lic.
When you buy a Polyspace product, the license file is provided.

Note The server name or IP address must be updated in the license file
(see “Configure a Concurrent License” on page 4-18).

7 In the Path to the debug log file” filed, enter the required file path.
Alternatively, click Browse and navigate to the debug log file for this
license server. You must have already created the file in a permanent
folder.

8 Select the Use Services and Start Server at Power Up check boxes.

9 Click Save Service to save the new Polyspace FLEXlm Server service.

10 Click the Start/Stop/Reread tab.
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11 Click Start Server to start the FlexNet server .

Note Any modification to license.lic requires the server to reread the
license file. To reread the license file, click ReRead License File.

12 Click the Server Status tab.

13 To verify the status of the server, click Perform Status Enquiry.

On the output window, a message provides the status of the server and of
the license file (see format in “Concurrent License File Format” on page
4-21).

Install FlexNet Manager on Linux Systems

• “Software Location” on page 4-17

• “Install the FlexNet Server” on page 4-17

• “Configure the FlexNet Server” on page 4-18

FlexNet Manager is not installed as part of the Polyspace software
installation.

Software Location. The FlexNet software components are located on the
Polyspace products DVD in:

DVD/Data/Unix/FLEXLM.

This folder contains a subfolder, glnxa64, that concerns all Linux operating
systems supported by Polyspace software.

Install the FlexNet Server. Installation consists of a copy and paste:

1 Copy the DVD/Data/Unix/FLEXLM/glnxa64 folder to a permanent folder
on the machine.

2 Copy the license file license.dat to this permanent folder.
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Configure the FlexNet Server. Before setting up the FlexNet server, you
must update the license.dat file with the name of the server, or its IP
address. For more information, see “Configure a Concurrent License” on
page 4-18.

To configure the license server on a Linux system, start the FlexNet daemon
server:

FLEXnetPath/lmgrd -c license_lic_path -l filename.log &

license_lic_path is the absolute location of the license.dat file. Starting
the server with the option -l filename.log allows you to have a log file
where all accesses and exchanges are recorded to a file named filename.log.

In the following example, all files are in /usr/local/Polyspace/FLEXnet:

/usr/local/Polyspace/FLEXnet/lmgrd -c
/usr/local/Polyspace/FLEXnet/license.dat -l
/usr/local/Polyspace/FLEXnet/FLEXnet.log &

./lmgrd -h provides more information about all available options of the
program. In addition, the FLEXnet.log file provides a state of the FlexNet
server.

./lmutil -h provides more information about all available options of the
lmutil program.

Configure a Concurrent License

• “Overview” on page 4-19

• “Configure Licenses on a Polyspace Client or Polyspace Server System”
on page 4-19

• “Configure Licenses on the FlexNet Server System” on page 4-21

• “Concurrent License File Format” on page 4-21
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Overview
A concurrent license requires a FlexNet server. Before configuring a
concurrent license, you must install the FlexNet server from the Polyspace
DVD. For more information about installing the FlexNet server, refer to
“Install FlexNet Manager” on page 4-15

To obtain a concurrent license, you must provide the MAC address of the
machine where you will install the FlexNet server manager. For more
information, see “Obtain a License File” on page 4-4.

For example, if you provide the following information:

• MAC address – 00123456abc1

• Hostname – MyFlexServer

You will receive a license file that looks like the following:

BEGIN------cut here------CUT HERE-----BEGIN
# MATLAB license passcode file.
# LicenseNo: 517786 HostID: 00123456abc1
INCREMENT Polyspace_Server_ADA MLM 19 01-jan-0000 2 \

A1B2C3D4E891011AB HOSTID=ID=517786 SN=517786
INCREMENT Polyspace_Client_ADA MLM 19 01-jan-0000 1 \

A1B2C3D4E891011AB HOSTID=ID=517786 SN=517786
# END------cut here------CUT HERE-----END

This license file contains a line for a concurrent Polyspace Server for Ada
license, and a line for a Polyspace Client for Ada license.

Depending on whether you plan to use the license on the Polyspace client
system, the Polyspace server system, or on the machine where you installed
the FLEXnet manager, you must make some modifications to the file.

Configure Licenses on a Polyspace Client or Polyspace Server
System
As the license mechanism is compatible with the environment variables
LM_LICENSE_FILE and MLM_LICENSE_FILE on either a client or server system,
you have two options:
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• Set the environment variable LM_LICENSE_FILE using the command:

set LM_LICENSE_FILE=27000@MyFlexServer

where 27000 is the port on which to reach the FlexNet server on the host
MyFlexServer.

• Create a license.dat file containing the following two lines:

SERVER MyFlexServer 00123456abc1 27000
USE_SERVER

Then, place the license.dat file in Polyspace_Install\licenses. If you
do not specify a port number, the default value is 27000.
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Configure Licenses on the FlexNet Server System
After copying the FlexNet tools to a folder on the dedicated MyFlexServer
host, you must update the license file by adding the following lines at the
top of the license.dat file:

SERVER MyFlexServer 00123456abc1
VENDOR MLM
INCREMENT Polyspace_Server_ADA MLM 19 01-jan-0000 2 \

A1B2C3D4E891011AB HOSTID=ID=517786 SN=517786
INCREMENT Polyspace_Client_ADA MLM 19 01-jan-0000 1 \

A1BCD3EF12311078A HOSTID=ID=517786 SN=517786

If you use an IP address as your hostid, insert the keyword INTERNET= before
the hostid. For example:

SERVER this_host INTERNET=10.94.78.128

The license file is now fully compatible with a standard FlexNet mechanism.
For more information, refer to the FlexNet Licensing End User’s Guide
throughwww.globes.com.

If you want to add the features of the license file to an existing FlexNet server,
use this procedure as well.

You can install the FlexNet server on a Polyspace Client machine, a Polyspace
Server machine, or any machine on the same network.

Concurrent License File Format
This license file requires a FlexNet license manager that is running. It has
the following format:

SERVER server_name server_hostid
VENDOR MLM
INCREMENT Polyspace_Feature MLM passcode_version_number
date_of_license_end number_of_licenses key
HOSTID=internal_number DUP_GROUP=UH SN=a_serial_number

• server_name— name of the FlexNet server or IP address.
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Note When the location of the FlexNet server changes, server_name is
the only value that an administrator can edit (with an ASCII editor). The
administrator can edit this file and change server_name before setting up
the FlexNet server (see “Configure the License Manager” on page 4-16
for Windows systems, or “Configure the FlexNet Server” on page 4-18 for
Linux systems).

• server_hostid — hostid of the server, usually the MAC address on
Linux systems and the disk serial number on Windows systems. The
server_hostid is required to obtain a license file from MathWorks. See
Getting the License hostid.

• MLM: Vendor daemon for Polyspace products licensing.

• Polyspace_Feature — type of license.

Polyspace Feature License Type

Polyspace_Client_Ada Polyspace Client for Ada

Polyspace_Server_Ada Polyspace Server for Ada.

• passcode_version_number and date_of_license_end — available
maintenance (and end dates).

• number_of_licenses— number of available licenses for a given type.

Example:

# MATLAB license passcode file.
# LicenseNo: 517786 HostID: 00123456abc1
SERVER dev13 831da5d6
VENDOR MLM
INCREMENT Polyspace_Client_ADA MLM 17 3-jan-2008 20 DF1FB89EB243
HOSTID=ID=12345 DUP_GROUP=UH SN=12345

INCREMENT Polyspace_Server_ADA MLM 17 3-jan-2008 20 9BFB0453E70F
HOSTID=ID=1234E DUP_GROUP=UH SN=1234E
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Install Licenses on an Existing FlexNet Server
If you are already using a FlexNet license manager, refer to the FlexNet
Manager documentation for information on how to add licenses for
your Polyspace software. You can access the documentation through
http://www.flexerasoftware.com.

Note The lmgrd or lmgrd.exe service, lmutils and lmtools must have the
correct version number. Polyspace products support FlexNet Version 10.8.
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Check Installed Licenses
You can check which Polyspace licenses are installed on your system using
the polyspace-ver command.

The polyspace-ver command provides the following configuration
information:

• Hardware configuration

• Operating system

• Polyspace licenses

• Specific version numbers for Polyspace products

• Any installed Bug Report patches

To obtain your configuration information, run the following command:

• UNIX/Linux— Polyspace_Install/polyspace/bin/polyspace-ver

• Windows— Polyspace_Install/polyspace/bin/polyspace-ver.exe

Note In the Polyspace verification environment, you can obtain the same
information by selecting Help > About.
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License Error Messages

In this section...

“Overview” on page 4-25

“Error -15, the FlexNet server is unreachable” on page 4-25

“Error -5, the Polyspace feature is not available” on page 4-26

“Error -21, license file does not support this version” on page 4-26

“Error -10, the license date has expired” on page 4-26

Overview
After a license check, most of the error messages are displayed in the log file.

However, because licensing is checked during code verification, a message
can also be displayed at any location in the associated Polyspace log file. An
error generally stops the verification.

This section describes common licensing errors. For other errors,
please refer to the FlexNet Licensing End User Guide available through
http://www.flexerasoftware.com.

Error -15, the FlexNet server is unreachable
Checking license ...
Unable to checkout feature Polyspace_Client_ADA for version 17:
Cannot connect to license server system.
The license server manager (lmgrd) has not been started yet,
the wrong port@host or license file is being used, or the
port or hostname in the license file has been changed.

Feature: Polyspace_Client_ADA
Server name: fitou
License path: /usr/local/attol/atu/v33a/sun4/sunOS5/bin/license.txt:

/usr/local.rhone/pst/tmp/nnu.lic:/usr/local.rhone/pst/*.lic
FLEXnet Licensing error:-15,570. System Error: 115 "Operation
now in progress"
For further information, refer to the FLEXnet Licensing
End User Guide, available at "www.flexerasoftware.com".
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*** License error
*** Aborting.

Error -5, the Polyspace feature is not available
Checking license ...
Unable to checkout feature Polyspace_Client_ADA for version 17:
No such feature exists.
Feature: Polyspace_Client_ADA
License path: /usr/local/attol/atu/v33a/sun4/sunOS5/bin/license.txt:

/usr/local.rhone/pst/tmp/nnu.lic:/usr/local.rhone/pst/*.lic
FLEXnet Licensing error:-5,357
For further information, refer to the FLEXnet Licensing
End User Guide, available at "www.flexerasoftware.com".
*** License error
*** Aborting.

Error -21, license file does not support this version
Checking license ...
Unable to checkout feature Polyspace_Client_ADA for version 17:
License file does not support this version.
Feature: Polyspace_Client_ADA
Application version > License version: 17 > 16
License path: /usr/local/attol/atu/v33a/sun4/sunOS5/bin/license.txt:

/usr/local.rhone/pst/tmp/nnu.lic:/usr/local.rhone/pst/*.lic
FLEXnet Licensing error:-21,126
For further information, refer to the FLEXnet Licensing
End User Guide, available at "www.flexerasoftware.com".
*** License error
*** Aborting.

Error -10, the license date has expired
Checking license ...
Unable to checkout feature Polyspace_Client_ADA for version 17:
Feature has expired.
Feature: Polyspace_Client_ADA
Expire date: 31-jan-2007
License path: /usr/local/attol/atu/v33a/sun4/sunOS5/bin/license.txt:

/usr/local.rhone/pst/tmp/nnu.lic:/usr/local.rhone/pst/*.lic
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FLEXnet Licensing error:-10,32
For further information, refer to the FLEXnet Licensing
End User Guide, available at "www.flexerasoftware.com".
*** License error
*** Aborting.
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